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NGOB ASSOCIATION PRESIDENT 

SELECTED FOR ARMY WAR COLLEGE

 Dr. Bruce McLelland, president of the NGOB Assn.

Recently began studies as a fellow at the Army War

College in Carlisle,PA. Bruce has over 22 years of 

combined military and civil service and has been an

analyst in the Pentagon’s Army Enlisted Division for

14 years. We send our congratulations to Bruce on 

this significant career achievement. His presence is

missed in the Pentagon, but the world of government

will be much better served with Bruce sharing in 

unique insights with students from all walks of life

and Nationalities at the War College.       
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PATRIOTISM (CONTINUED FROM PREVIOUS PAGE)

 An example of the feeble strength of patriotism starts in the

classrooms. During the Pledge of Allegiance, one can easily 

notice half the students not paying much attention to the pro-

cedure “because we don’t know how we got what we got.”

They do not understand that American freedom comes at an 

extremely costly price.

 Every war, every life can be accredited to freedom’s expense,

From the revolutionary war of independence from Britain to

Desert Storm and Bosnia. Americans had to fight hard on the 

road towards freedom. If it was not for such determination 

through the heart and soul, the United States, as the world 

knows it today, would not have survived. The U.S. Constitution,

the Declaration of Independence, everything that symbolizes

freedom would exist only in a state of oblivion. This know-

ledge is what inspires patriotism to live. If more Americans

obtain this knowledge, possibly by serving in the military or by

other means, then patriotism would flourish throughout a

blossoming nation.

Note: Corina Santos recently graduated from Bad Kreznach

High school, Heidelberg, Germany.

ARTICLES SOLICITED

 Any member desiring to submit an article,

notification of awards, or any items of general 

interest to our readers is invited to send it to our

post office Box number. Don’t be embarrassed by

an inability to write, it hasn’t stopped any of us 

yet.-editor.

AMERICAN ICONS


SGM Jerry Pionk


Executive Director


 


Time catches up with us all, and as we approach the millennium, it’s time to reflect on some great Americans who are no longer with us and those who are rapidly passing from the scene.  Life and death is part of the natural scheme of nature, but still it leaves a melancholy feeling as one generation passes and another assumes its place. I’m talking about the World War II generation.  Think of some of the big names we’ve lost recently; icons of the American scene such as singer Frank Sinatra, actor Jimmy Stewart, Astronaut Alan Shepard, and a host of others.  I mention this because young people too often ignore the advice of their elders and then go on to make the same mistakes.  This has probably happened throughout time and future generations will be no different. I recently went to the movie Saving Private Ryan.  If you haven’t seen it already, make sure you take the time to do so. It will leave a profound impact and give you a new found respect for those who sacrificed everything. I could not imagine being in the situation portrayed so graphically in the movie’s first half hour, but any person who has been called upon to serve, not knowing the outcome, but still answering the call to duty deserves the respect of their nation and those generations who follow.  As Veteran’s Day approaches and you see some “old guys or ladies” selling poppies or wearing their veteran’s hats, stop to thank them for all they’ve done, and while you’re at it talk to them, not only about the past, but also the future, you might just learn something and you’ll feel a whole lot better.  Our Association exists as a group of veterans who wish to “give back to America” through public speaking and helping the youth of tomorrow, but first we must understand where we obtained the freedom to  speak in the first place.  It was through the hardships and sacrifices of our veterans and elders! We exist because they were willing to lay it all on the line.  Many of America’s leaders of today are non-veterans and part of a younger generation who need  








to be reminded of the past so they don’t make the mistakes of previous generations.  As part of our Association’s charter, we exist to educate Americans on freedom, the opportunity to attain whatever dream the American lifestyle may offer and to then share our experiences with others so that they eventually have the opportunity to do the same.  Our Speaker’s Bureau  provides the means to share our experiences and those who came before us with corporations, schools, individuals and civic groups.  Any member who desires to register as a member of the NGOB Speaker’s Bureau, please drop us a line or notify us through the internet once out Web Page becomes fully functional (NGOB.ORG).     


Awards and Honors


 The Order of the NGOB, our Association’s highest honor is automatically awarded to our lifetime and 3 year paid up members. Additionally, the Order of the NGOB may be bestowed upon any Commander, Officer, Noncommissioned Officer or eligible civilian by any paid up lifetime member.  Only one such award may be conferred per life member per year. Non-member recipients must have contributed significantly to the Association goals of recruiting and retention in the Armed Forces. Although not required, it is recommended that recipients pay for an annual Association membership. If no membership fee is paid, a nominal $20.00 fee must be paid by the recommending member to defray the cost of the medallion, certificate and postage. Recent awards of the Order of the NGOB were conferred as follows:


Recipient 


CSM Jessie Deberry, Allied Command Europe


(Recommended by SGM Tony Rose)


CSM Stanley Ashford, AG Regimental CSM


(Recommended by SGM Jerry Pionk)


COL Russell L. Maziarka, V Corps AG  


(Recommended by SGM Luis Santos)


SGM Gilbert S. Morales, V Corps AG SGM


(Recommended by MSG Lujan-Rios) 


 Congratulations to these recent honorees.

















RETENTION HALL OF FAME INDUCTEES                 
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The styles available in this template allow you to change the look of your headlines and other text. The following is a list of some common styles and their uses.


Body Text - Use this style for the regular text of an article.


Byline - Use this style for the name of the author of an article.


Byline Company - Use this style to type the author’s company.


Sidebar Head - Use this style to type a second-level heading in a sidebar article.


Sidebar Subhead - Use this style to type a third-level heading in a sidebar article.


Sidebar Text - Use this style to type the text in a sidebar article.


Sidebar Title - Use this style to type first-level headings in a sidebar article.


Footer - Use this style to type the repeating text at the very bottom of each page.


Heading1 - Use this style to create headlines for each article.


Heading2 - Use this style to create section headings in an article.


Jump To and Jump From - Use these styles to indicate that an article continues on another page.


Mailing Address - Use this style in a mailing label to type the destination address.


Postage - Use this style in a mailing label to type postage information.


Return Address - Use this style in a mailing label to type your address.


Picture Caption - Use this style to type a description of a picture or illustration.


Subtitle - Use this style to type sub-headings in an article.


Use PullQuote to excerpt text from the main text of a story to draw a reader’s attention to the page. See page 4 for an example.


�





RECRUITING AND RETENTION IN THE ARMED FORCES- WHAT DOES THE FUTURE HOLD?


Editor’s Comments


 


From the point of view of the volunteer military, the recently ended fiscal year was a tough one. Since the advent of the volunteer military following the divisiveness of Vietnam, the Armed Forces have been relatively successful in recruiting and retaining a strong military. The late ‘70s were tough as the volunteer force experienced growing pains, but the 80’s and early 90’s showed that America did not need a conscript military.  In fact, the all volunteer force has been a showcase success story.  The fall of the Berlin Wall and the resounding success of Desert Storm were testimony to an effective policy that resulted in peace. The problem, in my opinion is that we were too successful.  The Armed Forces as we now know them bear little resemblance to the military known to our parents and grandparents.  The reason of course is the volunteer nature of the force.  No longer are young people forced to join or be drafted into the active or reserve components because of conscription.  While this trend is good for many, it has essentially changed America’s outlook on the military.  Many of us older service members and veterans, would never have gone into the military if the threat of being drafted did not exist.  While the volunteer force is good for citizens in general, it has placed current volunteers in the status of “out of sight-out of mind”.  Since the general populace is not as concerned about their individual family members having to participate in a military operation, they have not been as active in conveying their feelings to elected officials.  In turn, spending on military personnel and quality of life programs have suffered.  America needs to wake up and support the volunteer military or I personally foresee a return to some type of mandatory service.  It may not happen in the next couple of years, but down the road, in response to a threat to our way of life, we will have to have an adequate force that is ready to respond.  If current trends continue, the only step will be to force young Americans to serve.  Unfortunately, the people who most suffer when a calamity happens are the poor and underprivileged.  Of course, this can all be avoided by supporting a strong military and to compensate people adequately.  Why lay your life down for the same wage we pay a fast food worker?  A society is judged by how it treats its senior citizens. We are also judged by how we react to preserve what has been guaranteed to our veterans and military retirees. With the voting season upon us, take a long look at the candidates. What is their position on Armed Forces policies?  Have they served (this may not be fair, but it may offer an insight into the candidate’s potential) in the military?  Are they honorable?  Look carefully and regardless of party, VOTE- you can make a difference!   


Murtha appointed as NGOB Director of Retiree Affairs.


 Frank Murtha, Sergeant Major, US Army, retired, has volunteered to serve as the NGOB Association’s Director of Retiree Affairs.  Frank brings over 40 years of military service experience to the organization and has already made his voice known in Washington.  On September 22 of this year, Frank met on the steps of the nation’s Capitol along with representatives from many other veteran’s organizations to discuss medical care for veterans and military retirees and other eroding benefits. Retired Colonel George E. Day and retired Admiral  Richard Stockdale,  both former prisoners of war in Vietnam and Congressional Medal of Honor  recipients were on hand to speak on behalf of the group.  Senator John McCain, himself a former POW from Vietnam and many other elected officials were on hand to lend their support to Veteran’s benefits and the military. Frank Murtha will continue to represent our Association in future events as well. Any member who would like to contact Frank via e-mail may do so at � HYPERLINK mailto:VDMURT@AOL.COM ��VDMURT@AOL.COM�.  He would be happy to hear from you and loves hearing from the Army’s retention community. 


COMBINED FEDERAL CAMPAIGN


 As a reminder, the Not Good Old Boys Association (NGOBs) is a participant in the Combined Federal Campaign.  Since we are only listed in the Washington DC area’s listings, you may have trouble making donations in your local area.  Our CFC number is 7679.  We will donate 100% of our CFC take for 1998 to our education scholarship fund. Last year we gave five grants to worthy students and this year we hope to give more.  Although not listed in your local CFC guide, we are told that by placing our number in the blanks on the CFC form, any donations will get to the Association. We hope next year to get into the International listing and also in the United Way. 


1998 Student Education Grant/Essay Winners Announced.


 In the last issue of The Gazette, we printed an essay by Heather Lee of Dumfries, VA one of our five National Essay winners for 1998.  Our 1998 essay theme was “Patriotism in America-Is it Alive?” Later in this issue is another of our essay submissions, from our European Chapter essay winner, Corina Santos, a recent graduate of Bad Kreuznach High School in Germany.  We will run other essays in future issues.  All our essay participants will receive a monetary grant from the Association.  We will announce the 1999 essay contest theme and rules in the next issue of The Gazette.  Our intent is to award 100% of our proceeds from the Combined Federal Campaign to our youth scholarship fund. As we grow in size and scope we hope to make significant contributions to young Americans who demonstrate the principles and ideals of patriotism that support our democratic way of life. 














Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(
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Calendar of Events


World wide army retention conference


Anaheim, CA


26-30 October 1998





European army Retention conference


chiemsee, germany


30 november-4 december 1998





army national Guard strength management conference


12-15 november 1998


alexandria, va


Chief’s Strength Management Awards and Seminars 


US Army recruiting command conference


30 November-4 december 1998  


FORT KNOX, KY


Annual Sergeant’s Major Conference 





continued from page 1








MORE AWARDS AND HONORS 


RETENTION HALL OF FAME


Congratulations to the following soon to be retired Association members who have been selected for induction into the US Army Retention Hall of Fame:


SGM William Allen


 Bill will be retiring this spring after 26 years Army service. Bill’s induction into the Hall of Fame will be a precedence setter, since he is already a member by virtue of his status as a former Secretary of the Army’s Career Counselor of the Year.  His contributions to the field are noteworthy, however and his election based on his career achievements is greatly deserved. He has guided the Forces Command retention program through an arduous time in its history. Through his efforts and innovative techniques, FORSCOM exceeded all retention objectives during his tenure. He was the driving force behind documentation of retention positions and utilization of counselors in deployed environments.   


SGM Clark Loper


 Clark is retiring from the Army after over 30 years active service. Although he has superbly served in numerous retention positions during his tenure, his major contributions came in his current assignment as Senior Instructor of the Army Retention Course, Fort Jackson, SC.  SGM Loper’s management techniques were instrumental in obtaining funding for the Mobile Retention Training Team, revitalizing and revamping the basic and advanced retention courses and integrating the Reserve Component course into the total Army format. His previous contributions as senior counselor with the 3rd Infantry division in Europe and the 7th Infantry Division, Fort Ord, CA set the template for successful Division level retention management. 


NGOB DMFPOS OF THE YEAR NAMED


 At the local level of our association are the Devoted Military Follower Placed over Subordinates (DMFPOS). They are the ones who keep traditions alive at the local level, and through innovative techniques, make meetings enjoyable.  SFC Javier Gomez, European Chapter, and MSG(R) Donald Wong, Korean Chapter will both be formally recognized with the annual Award of Merit during the respective Europe and Korea conferences. 











Patriotism in America-Is It Still Alive?


By Corina Santos


 Patriotism exists in America, but it does not thrive throughout the entire nation or through all generations. It can be defined as the devoted, love, support, and defense of one’s country. The question should not ask whether or not patriotism still lives in America, instead it should inquire as to the strength of national loyalty. If nationalism did not persist, then the government would diminish as the result of anarchy. Numerous patriots believe that the elimination of the military draft is a major factor that led to the reduction of national enthusiasm.


  In 1940, Congress instituted the draft for the first time in America’s peacetime history. Young men were registered en masse by the Selective service System. President Gerald Ford suspended the program because he planned to substitute a new system of periodic registration. His plan was deferred by political opposition, thereby putting the Selective service System on hiatus.


 The Soviet invasion of Afghanistan, in 1980, became the world’s newest killing field. In order to demonstrate America’s war/defensive capabilities, President jimmy Carter ordered the resumption of draft registration. His move turned out to be his most memorable legacy.        Currently, all men must register within 30 days of their eighteenth birthday. If they refuse, they will be unable to receive financial aid for college, student loans, federal jobs or U.S. citizenship. Those who dodge the draft could face prosecution as well.


 Rather  than simply registering, various military veterans believe that a mandatory draft service time should be inaugurated. Germany holds an exceptional and ideal concept. German men must serve a minimum of two years when they reach the age of eighteen. The only exception to this program is if the prospective  soldiers are married by the age requirement. Vietnam veterans especially, feel the elimination of the military draft weakened the sense of patriotism in America. Since the draft’s “death”, it seems that there is no longer a focus on national unity.


  (continued on page 5)








Patriotism in America-Is It Still Alive?


By Corina Santos


 Patriotism exists in America, but it does not thrive throughout the entire nation or through all generations. It can be defined as the devoted, love, support, and defense of one’s country. The question should not ask whether or not patriotism still lives in America, instead it should inquire as to the strength of national loyalty. If nationalism did not persist, then the government would diminish as the result of anarchy. Numerous patriots believe that the elimination of the military draft is a major factor that led to the reduction of national enthusiasm.


  In 1940, Congress instituted the draft for the first time in America’s peacetime history. Young men were registered en masse by the Selective service System. President Gerald Ford suspended the program because he planned to substitute a new system of periodic registration. His plan was deferred by political opposition, thereby putting the Selective service System on hiatus.


 The Soviet invasion of Afghanistan, in 1980, became the world’s newest killing field. In order to demonstrate America’s war/defensive capabilities, President jimmy Carter ordered the resumption of draft registration. His move turned out to be his most memorable legacy.        Currently, all men must register within 30 days of their eighteenth birthday. If they refuse, they will be unable to receive financial aid for college, student loans, federal jobs or U.S. citizenship. Those who dodge the draft could face prosecution as well.


 Rather  than simply registering, various military veterans believe that a mandatory draft service time should be inaugurated. Germany holds an exceptional and ideal concept. German men must serve a minimum of two years when they reach the age of eighteen. The only exception to this program is if the prospective  soldiers are married by the age requirement. Vietnam veterans especially, feel the elimination of the military draft weakened the sense of patriotism in America. Since the draft’s “death”, it seems that there is no longer a focus on national unity.


  (continued on next page)


(Patriotism, continued from page 4)


 An example of the feeble strength of patriotism starts in the classrooms. During the Pledge of Allegiance, one can easily notice half the students not paying much attention to the procedure “because we don’t know how we got what we got.”  They do not understand that American freedom comes at an extremely costly price.


 Every war, every life, can be accredited to freedom’s expense, from the revolutionary war of independence from Britain to Desert Storm and Bosnia. Americans had to fight hard on the road towards freedom. If it was not for such determination through the heart and soul, the United States, as the world knows it today, would not have survived. The U.S. Constitution, the Declaration of Independence, everything that symbolizes freedom would exist only in a state of oblivion. This knowledge is what inspires patriotism to live. If more Americans obtain this knowledge, possibly by serving in the military or by other means, then patriotism would flourish throughout a blossoming nation.   


Note: Corina Marie Santos recently graduated from Bad Kreuznach High School, Heidelberg, Germany. 





MORE AWARDS AND HONORS 


RETENTION HALL OF FAME


Congratulations to the following soon to be retired Association members who have been selected for induction into the US Army Retention Hall of Fame:


SGM William Allen


 Bill will be retiring this spring after 26 years Army service. Bill’s induction into the Hall of Fame will be a precedence setter, since he is already a member by virtue of his status as a former Secretary of the Army’s Career Counselor of the Year.  His contributions to the field are noteworthy, however and his election based on his career achievements is greatly deserved. He has guided the Forces Command retention program through an arduous time in its history. Through his efforts and innovative techniques, FORSCOM exceeded all retention objectives during his tenure. He was the driving force behind documentation of retention positions and utilization of counselors in deployed environments.   


SGM Clark Loper


 Clark is retiring from the Army after over 30 years active service. Although he has superbly served in numerous retention positions during his tenure, his major contributions came in his current assignment as Senior Instructor of the Army Retention Course, Fort Jackson, SC.  SGM Loper’s management techniques were instrumental in obtaining funding for the Mobile Retention Training Team, revitalizing and revamping the basic and advanced retention courses and integrating the Reserve Component course into the total Army format. His previous contributions as senior counselor with the 3rd Infantry division in Europe and the 7th Infantry Division, Fort Ord, CA set the template for successful Division level retention management. 


NGOB DMFPOS OF THE YEAR NAMED


 At the local level of our association are the Devoted Military Follower Placed over Subordinates (DMFPOS). They are the ones who keep traditions alive at the local level, and through innovative techniques, make meetings enjoyable.  SFC Javier Gomez, European Chapter, and MSG(R) Donald Wong, Korean Chapter will both be formally recognized with the annual Award of Merit during the respective Europe and Korea conferences. 
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